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ABOUT THIS TRAINING WORKBOOK

This workbook provides practical examples of how to use SDL MultiTerm 2014. You will learn the 
following:

C What is terminology?

C Starting the application

C Overview of the user interface

C Searching terms in SDL MultiTerm

C Adding, editing and deleting entries

C Generating termbases from existing glossaries in Microsoft Excel format

C Setting up your own termbase definitions

C Extracting terminology from translated files

C Exporting terminology to e.g. Word or Excel format

C Keeping termbases lean and efficient

C Using SDL MultiTerm in your translation environment, i.e. SDL Trados Studio 2014

C What is SDL MultiTerm Online?

The main focus of this training guide is on practical life examples, for which training sample files are 
available.

We recommend that you copy the sample files to your desktop, so that you can find them more easily, i.e. 
..\Desktop\Sample Files.
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ABOUT TERMBASES

This chapter provides general information on SDL MultiTerm 
and terminology. You will learn the following:

C What are termbases and how can they be used?

C What is a concept-oriented termbase?

2
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WHAT IS A TERMBASE?

Every organization uses specific terms that cannot be found find in standard dictionaries. Example: 
Microsoft uses the term favorites in Internet Explorer. In other Web browsers the same feature is referred 
to as bookmarks. For an organization it is important to use the correct terms consistently in all forms of 
communication, e.g. technical manuals, support articles, knowledge bases. 

When translating documentation into other languages it is equally important to use standardized 
translations consistently. For example, the standard German translation for dialog box is Dialogfeld. The 
standard French translation is boîte de dialogue. If you fail to use the correct target terms, readers are likely 
to get confused, which may lead to misunderstandings, time-consuming support calls, etc.

Termbases are used to store organization-specific terms and their translations. This helps you do the 
following:

C Research terms quickly

C Translate terms consistently owing to the tight integration of SDL MultiTerm termbases into your 
translation environment, SDL Trados Studio 2014

A termbase allows you to enter additional information for each term. For example, you can have a Status 
field that indicates whether a term is obsolete, derogatory, not allowed/approved, preferred, etc. Also, you 
can use so-called descriptive fields (e.g. Definition, Note, Example, Context) to provide additional 
information on a term. A termbase can even contain multimedia objects, e.g. pictures or videos, as well as 
cross-references and hyperlinks.

ADDING CONTENT TO A TERMBASE

Except for a small sample termbase (which we are going to use for this training), SDL MultiTerm is not 
delivered with any content during installation. However, you can download termbases from our 
OpenExchange site at: http://www.sdl.com/en/language-technology/sdl-openexchange/

Termbases needs to be filled by the user, as your corporate terminology or the terminology of your client 
will always be organization-specific. Termbases can be filled in any of the following ways:

C By adding entries manually

C By conversion of existing word lists (e.g. Microsoft Excel glossaries): SDL MultiTerm is delivered 
with a supplementary tool called SDL MultiTerm Convert, which allows you to quickly convert e.g. 
existing Microsoft Excel glossaries into SDL MultiTerm format

C By extracting terminology from existing source and/or target documents: terminology extraction 
can be done, for example, in SDL MultiTerm Extract, which is a separate product

C By creating of quick entries directly from your translation environment, i.e. SDL Trados Studio 2014

WHAT IS A CONCEPT-ORIENTED TERMBASE?

SDL MultiTerm termbases use a concept-oriented approach. In a classic dictionary each term is an entry. 
For example, the word car is listed under C, while the word automobile is listed under A. In a concept-
oriented database all terms that belong to the same concept can be found in the same entry. Example: 
when you look up the term car in a concept-oriented termbase, synonyms such as vehicle, auto, automobile, 
are also shown (if available).

Unlike a classic dictionary, a termbase allows you to work with any language direction. You can select your 
preferred language pair as required. 
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THE SDL MULTITERM USER
INTERFACE

This chapter provides an overview of the SDL MultiTerm user 
interface. You will learn how to:

C Start the application

C Open a termbase

C Handle the user interface

3



The  SDL  Mul t iTe rm User  In te r face3

3-2     SDL MULTITERM 2014
SDL plc Confidential. Copyright ¤�2013 SDL plc.

STARTING THE APPLICATION

To start the SDL MultiTerm take the following steps:

1. Click the Windows Start button, then select the program group All Programs -> SDL -> SDL 
MultiTerm 2014, and click the SDL MultiTerm 2014 Desktop application icon.

2. After SDL MultiTerm has launched, maximize the application window by clicking the 
Maximize button in the top right corner.

OPENING A TERMBASE

To open the sample termbase take the following steps:

1. Switch to the File tab in the application ribbon, then click Open Termbase.

2. In the Select Termbases dialog box click the Browse button.

3. Browse to the location where your sample termbases are stored, i.e. ..\Sample 
Files\Termbases.

4. Select the termbase file Hardware.sdltb by double-clicking it.
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5. In the Select Termbases dialog box make sure that the box next to Hardware Termbase is 
checked. 

6. Click OK to open the termbase in SDL MultiTerm, which now looks as shown below:

THE APPLICATION WINDOWS

The application has a number of views and windows, which serve different purposes and functions.
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The Entry Pane
The sample termbase that you just opened contains hardware-related terms in the following languages: 
German, English, French, Spanish, Portuguese, Chinese, and Japanese. The terms in the available 
languages are shown in the Entry pane on the right hand side. Apart from the terms, some entries also 
contain additional information such as definitions, usage examples, graphics, etc.

FOR MORE INFORMATION
V

The Entry Pane

The Browse List
The Browse list on the left-hand side lists the terms of the selected source language in alphabetical order. 
Clicking a term in the Browse list displays the full entry in the Entry pane on the right-hand side. You can 
move up and down in the Browse list by using the Up and Down keys on your keyboard.

FOR MORE INFORMATION
V

The Browse Tab

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Getting_Started/Screen_Layout_and_Functionality/Term_View/The_Navigation_Pane/The_Browse_Tab.htm
http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Getting_Started/Screen_Layout_and_Functionality/Term_View/The_Entry_Pane/About_the_Entry_Pane.htm
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The Hitlist
When you perform a search in the termbase, the Browse list switches to the Hitlist view, which contains 
the results of your search (if any). At the moment the Hitlist is empty, as you have not launched a search 
yet.

The next chapter provides examples of how to search terms in a termbase.

FOR MORE INFORMATION
V

The Hitlist Tab

The Termbases List
Click the Termbases tab to switch to the Termbases list. At the moment only one termbases is listed here, 
i.e. the termbase that you have just opened. This list is especially useful when you have several termbases 
open at the same time. In SDL MultiTerm you can search many termbases in parallel.

FOR MORE INFORMATION
V

The Termbases Tab

The Terms View

All of the above lists (i.e. Browse, Hitlist, Termbases) are accessible from the Terms view. In this view you 
perform day-to-day operations such as searching, adding and editing terms. 

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Getting_Started/Screen_Layout_and_Functionality/Term_View/The_Navigation_Pane/The_Hitlist.htm
http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Getting_Started/Screen_Layout_and_Functionality/Term_View/The_Navigation_Pane/The_Termbases_Tab.htm


The  SDL  Mul t iTe rm User  In te r face3

3-6     SDL MULTITERM 2014
SDL plc Confidential. Copyright ¤�2013 SDL plc.

The Termbase Management View
The Termbase Management provides access to advanced functionality such as filtering, importing, 
exporting, etc. Click the Termbase Management button to switch to the corresponding view.

On the right-hand side you can now view some general information on the termbase. The most interesting 
part is the Statistics section, which shows the following:

C The total number of termbase entries (34)

C The total number of multimedia objects, i.e. graphics (4)

C The number of terms for each language

NOTED
An entry can contain more than one term in a particular language. In one entry you can store, for 
example, synonyms, approved terms, obsolete terms, etc. This is why the number of English terms 
(48) in the current example is greater than the total number of termbase entries (34).

FOR MORE INFORMATION
V

About the Catalog View

Resizing / Moving Windows and Auto Hide
Click the Terms button to switch back to the Browse list. SDL MultiTerm in fact allows you resize and 
move the windows within the application.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Getting_Started/Screen_Layout_and_Functionality/Catalog_View/About_the_Catalog_View.htm
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C Resize: You can resize the Browse list by placing the mouse pointer between the Browse list and the 
Entry pane and by moving the mouse pointer to the left or to he right.

C Auto-hide: You can auto-hide the Browse list by clicking the Auto Hide (pin) button in the upper 
right corner of the window. If the pin is pointing to the left, the list automatically disappears when 
you move the mouse pointer out of it. 

 
When you move the mouse pointer over the Browse tab, the list will reappear.  

If you move the mouse pointer out of the Browse list, it will disappear again. You can disable Auto 
Hide and lock the position of the list by clicking the pin button once more. When the pin icon is 
pointing down, the list stays locked in its current position.

C Moving and docking: You can move the Browse list within the application or even drag and position 
it outside of the SDL MultiTerm application. For example, you can move the list to a second screen. 
To move the list take the following steps:

C Move mouse pointer over the title bar of the list and press the left mouse button.
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C While keeping the left mouse button pressed, start moving the list to another position. (You 
can also move it to a position outside of the application window.)

TIPE
If you have accidentally moved or closed windows, and you do not know how to reopen them, just 
select the Reset Window Layout command on the View tab, and confirm by clicking Yes. This will 
reset all application windows to their factory settings.

The Application Ribbon
On the top of the application you will find the ribbon, which provides access to various functions.

Note that the buttons available on the ribbon change depending on the view that you have selected. In the 
Terms view you will find, e.g. termbase search functionality.

While in the Termbase Management view, the buttons for e.g. reorganizing or deleting termbases are 
available.
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SEARCHING TERMBASES

This chapter provides examples of how to search a termbase. 
You will learn how to:

C Select your preferred language pair

C Perform normal, wildcard, fuzzy, and full text searches

C Define a filter

C Perform a filtered search

C Search in multiple termbases

4



Search ing  Te rmbases 4

SDL MULTITERM 2014     4-2
SDL plc Confidential. Copyright ¤�2013 SDL plc.

SELECTING YOUR SOURCE AND TARGET LANGUAGE

First, make sure that you are in the Terms view. Searches are usually executed in the selected source 
language. This is the language that is displayed in the source language dropdown list. For example, when 
you want to look up a German term, you need to make sure that the selected source language is German.

In the following exercises we are going to search for a number of English terms. Therefore, make sure that 
English is selected in the source language list. Then select your preferred target language (e.g. German) 
from the target language list, which you can find below the source language list.

Changing the source/target language pair will cause the following:

C The Browse list on the left-hand side contains English terms.

C The terms in the Entry pane are re-sorted, i.e. the source language term is shown on top. The target 
language term is listed second. Below the source and target terms you find the terms of all other 
languages, i.e. the languages that have not been selected as source or target language.

BROWSING THE TERMBASE

You can browse the termbase by clicking any one of the English terms listed on the left hand side. 
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For example, click the term LED.

This displays the corresponding entry in the Entry pane, i.e. LED, Light-emitting diode, and the translations 
in all available languages. Note that this entry contains additional information fields, e.g.

C Definition fields, which are used to further describe the terms.

C Status fields - for example, LED is marked as the preferred term, while Light-emitting diode is 
marked as a forbidden term.

NOTED
Fields such as Definition and Status are called descriptive fields. These can be freely defined when 
creating a termbase.

Now do the following: while the term LED is still highlighted in the Browse list, press the letter p on your 
keyboard. This will lead you to the first term that starts with p, i.e. Paper LED. Use the Down key on your 
keyboard to go further down to the term photo printer. This will show the corresponding entry, which is an 
example of an entry that contains a multimedia object, i.e. an image.

SEARCHING FOR PARTICULAR TERMS

SDL MultiTerm offers a number of search types to help you find the information that you are looking for. 
In the following sections you will learn how the different search types work.
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Normal Search
Let us assume that you want to look up the term adapter. To do this take the following steps:

1. Enter the search term (i.e. adapter) into the search text field. 

2. Execute the search by pressing the Enter key.

Executing a search switches the Browse list to the Hitlist. The Hitlist contains the source term that was 
found. On the right-hand side you see the full entry with the terms in all available languages.

FOR MORE INFORMATION
V

Performing a Normal Search

Wildcard Search
Let us assume that you want to look up all the terms that CONTAIN the word photo. To do this take the 
following steps:

1. Enter *photo* into the search text field.

2. Execute the search by pressing the Enter key.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Perform_a_Normal_Search.htm
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The hitlist now shows all terms that contain the word photo, e.g. Matrix Photolithograph. The asterisks used 
in the wildcard search act as placeholders for any string that precedes and follows the search term. 

Clicking a term in the hitlist shows the corresponding entry in the Entry pane.

FOR MORE INFORMATION
V

Using Wildcard Characters

Fuzzy Search
Let us assume that you want to look up the term color cartridge. However, you are unsure of the spelling of 
the word cartridge. Take the following steps:

1. Enter a misspelled term on purpose, e.g. color cardrige.

2. Execute the search by pressing the Enter key.

Note that this search yields no results, i.e. the hitlist is empty. However, SDL MultiTerm offers a powerful 
fuzzy search feature for exactly this kind of scenario. A fuzzy search yields results, even if you have badly 
misspelled a word. Now take the following steps:

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Using_Wildcard_Characters.htm
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1. To activate the fuzzy search click Normal Search below the search text field, then select Fuzzy Search 
from the list of available search types.

2. Click inside the search text field (which still contains the misspelled term) and press Enter to 
execute the search again.

The fuzzy search will yield two hit terms, i.e. color cartridge and color cartridge riboon.

NOTED
The term color cartridge riboon is misspelled in the termbase. We will correct this term in one of the 
following exercises.

FOR MORE INFORMATION
V

Performing a Fuzzy Search

Full Text Search
Note that all of the above types of search are only executed in the selected source language, i.e. the other 
languages are not searched, neither are the descriptive fields. Let us assume that you want to look up all 
entries in which the word paper occurs, for example, as part of a Definition field. To do this you have to 
activate the full text search. Take the following steps:

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Perfom_a_Fuzzy_Search.htm
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1. Click the Fuzzy Search button below the search text field, and then select the option Full Text 
Search.

2. Type the term paper into the search text field, then press Enter.

The hitlist now shows terms that, at first glace, have nothing to do with the search string. Take a look at 
the Entry pane on the right-hand side. You will see that the first hit contains the word papers in a Definition 
field. The the search expression is highlighted with a yellow background.

FOR MORE INFORMATION
V

Performing a Full Text Search

Returning only Terms with a Target
Some termbase entries contain terms in all available languages. However, it might also happen that an 
entry does not contain terms for all languages (usually users are not forced to provide a term for every 
language). It can therefore happen that when you perform a search you will see results in the hitlist. 
However, the corresponding entries might not always offer a translation in the language that you are 
actually interested in. For this reason, the search result might be of only of little use to you. SDL 
MultiTerm offers a simple way of suppressing such entries during a search. Take the following steps:

1. Make sure that French is selected as your target language.

2. Set the search type to Fuzzy Search.

3. Type the search term method into the search text field, then press Enter.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Perform_a_Full_Text_Search.htm
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Note that the hitlist contains two terms, i.e. methodology and proven methodology. However, no French 
translation is available for the term methodology. 

If you do not want the hitlist to show any results that do not offer a translation in your selected target 
language, then take the following steps:

1. Click the Require Target Term button.

2. Place your cursor inside the search text field and press Enter to execute the same search 
again.

Note that this time the hitlist only contains the term proven methodology, for which a French translation is 
available. The Only return terms with a target option is useful for suppressing results that do not offer a 
translation in the selected target language anyway. Before you proceed to the next exercise click the Only 
return terms with a target button again to deactivate this setting.

Showing the Target Term in the Hitlist
As you have seen, the target term is shown in the Entry window alongside all other fields. Let us assume, 
however, that you would like to see the target term directly in the hitlist. That way you can see the target 
term in the hitlist without having to look at the Entry window, which can be more ergonomic. To do this 
change the hitlist settings by taking the following steps:
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1. Right-click anywhere inside the hitlist and select Hitlist Settings from the context menu.

2. In the Hitlist Settings dialog box activate the Show target terms check box. Then close the 
dialog box by clicking OK.

3. Note that the target term is now directly displayed below the source term in the hitlist.

DEFINING AND USING FILTERS

Filters are useful for restricting a search to entries that match a specific criterion. In the following sections 
you will learn how to define and use filters.
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Creating a Simple Filter
Let us assume the following: you want to limit your searches to entries in which the English term has a 
definition. To do this take the following steps:

1. Click the Termbase Management button on the bottom of the Navigation pane.

2. Then right-click Filters and select the Create command from the context menu.

3. On the first page of the Filter Wizard click Next.

4. In step 1 of 3 of the Filter Wizard enter a descriptive name for your filter, e.g. Has English 
definition. Then click Next.

5. On the next page keep the default option Simple filter selected, and click Next.
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6. From the list on the left-hand side of the Filter Definition page select English and drill down 
to Term -> Definition. 

7. Then select is not missing from the Condition dropdown list.

8. Click Next and then Finish to create the filter.

FOR MORE INFORMATION
V

Creating a Filter

Using Filters in a Search
Now we will see how the filter actually works. Take the following steps:

1. Click the Terms button on the bottom of the Navigation pane.

2. Select your newly created filter from the Filter dropdown list.

3. Type the term printer into the search text field and press Enter.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Filters/Create_a_Filter.htm
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4. Note that the hitlist contains a number of results, some of which are grayed out. If you click 
one of the grayed-out hit terms in order to view the full entry, you will notice that the 
corresponding entry has a gray background. The gray background is used to flag hits that do 
not have an English definition, i.e. the entries that do not match the selected filter.

5. Let us assume that you do not want non-matching entries to be grayed out. Instead you 
prefer non-matching entries not to be shown in the first place. To do this click the Hard 
filtering button below the filter dropdown list. Then click inside the search text field and 
execute the search for the term printer again by pressing Enter. 

6. Note that the hitlist now only contains the terms that match your filter.

NOTED
Filters apply both to the Browse and the Hitlist list.

FOR MORE INFORMATION
V

Using Filters in Searches

Creating an Advanced Filter
Advanced filters are defined and applied in the same way as simple filters. There is only one difference 
between these two filter types: simple filters use only one criterion. Advanced filters can have multiple 
criteria. Example of an advanced filter: all entries created after 1st January 2009 AND that have an English 
definition.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Using_Filters.htm
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Let us assume that you want to define a filter that restricts your searches to entries that have more than 
one English term (i.e. that have synonyms) AND that have an English definition. To create such a filter 
take the following steps:

1. Click the Termbase Management button on the bottom of the Navigation pane.

2. Then right-click Filters and select the Create command from the context menu.

3. On the first page of the Filter Wizard click Next.

4. In step 1 of 3 of the Filter Wizard enter a name for your filter, e.g. English definition and 
synonyms. Then click Next.

5. On the next page select the Advanced filter radio button, and click Next.

6. Define the first criterion: from the list on the left-hand side of the Filter Definition page 
select English and drill down to Term -> Definition. Then select is not missing from the 
Condition dropdown list.

7. To add this criterion to the list below click the green check mark button (see below):

8. Now define the second criterion: select Term below English. 

9. On the right-hand side select the condition has synonyms from the dropdown list.



Search ing  Te rmbases 4

SDL MULTITERM 2014     4-14
SDL plc Confidential. Copyright ¤�2013 SDL plc.

10.  Click the button with the green check mark again to add the second criterion to the list 
below.

11. Click Next and then Finish to create the filter.

Note that using advanced filters in searches works just like using simple filters.

TIPE
If you just press Enter inside the (empty) search text field without typing a search string, you can 
retrieve the first 25 hits that match the filter. This can be useful for checking whether there are any 
matching entries in the termbase in the first place.

Before proceeding to the next exercise make sure to switch off the filter. To do this select the value (No 
filter) from the filter dropdown list.

SEARCHING MULTIPLE TERMBASES

SDL MultiTerm allows you to search multiple termbases sequentially. That way you can retrieve results 
from multiple terminology sources with a single search operation. 

To see how to perform searches in two termbases at the same time, open a second termbase by taking the 
following steps:

1. Switch to the File tab, and then click Open Termbase.
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2. In the Select Termbases dialog box click Browse and go to the location in which your sample 
termbases are stored. The second termbase can be found in the same folder as the first 
termbase, i.e. ..\Sample Files\Termbases.

3. Double-click the termbase file Software.sdltb to select it.

4. The Select Termbases dialog box should now list two termbases, i.e. Hardware Termbase and 
Software Termbase. Make sure that the box next to each termbase is checked.

5. Click OK to open the second termbase.

6. By default SDL MultiTerm searches the open termbases until a hit is found. This means that 
if a result is found in the first termbase, it will not continue the search in the second 
termbase. To make sure that both termbases are searched, click the Hierarchical Mode 
button below the search text field, and then select the Sequential Mode option.

7. Type the search term color into the search text field, then press Enter.
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8. Note that the hitlist contains results from both termbases, e.g. color cartridge from the 
Hardware Termbase, and color from the Software Termbase. The names of the termbase from 
which the results have been retrieved are shown above the hit terms.

FOR MORE INFORMATION
V

Searching Multiple Termbases

SEARCHING FROM OTHER APPLICATIONS

Up to this point you have learned how to do searches in SDL MultiTerm proper. However, it is also 
possible to do searches from within any other application, e.g. Microsoft Office. For this purpose the SDL 
MultiTerm package includes the SDL MultiTerm Widget. This application can run in the background and 
then be called for searching termbases from within any other 3rd party application.

To start the SDL MultiTerm Widget take the following steps:

1. Click the Windows Start button, then select the program group All Programs -> SDL -> SDL 
MultiTerm 2014, and click the SDL MultiTerm 2014 Widget application icon.

2. The SDL MultiTerm Widget looks as shown below:

Selecting a Termbase
Before you can search termbases from the widget, you need to select one or several termbases. To do this 
take the following steps:

1. Click the Configure button in the top right corner of the application window.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Searching_Multiple_Termbases.htm
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2. This opens a new window in which you can select termbases and configure further settings. 
Here, click the Open Termbases button.

3. In the Open Termbases dialog box click Browse. Then browse to the location of your sample 
termbases, i.e. ..\Sample Files\Termbases and select the termbase file Hardware.sdltb by 
double-clicking it. The termbase name will now be listed in the dialog box. 

4. Click OK to close the Open Termbases dialog box. Next, make certain that English is selected 
as your source language. Then select your preferred target language.
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5. Also activate the Search immediately check box. This ensures that any strings highlighted in 
a 3rd party application are automatically searched through the widget when you press the 
keyboard shortcut Ctrl+Alt+F8. 

6. Click OK to confirm the settings and close the configuration window.

Performing a Search from Word
As an example of a search from a 3rd party application we are going to use Microsoft Word. Take the 
following steps:

1. Open the document PhotoPrinter.doc,which is located in your sample files folder (..\Sample 
Files\Documents) in Microsoft Word.

2. Highlight the term photo printer, then press Ctrl+Alt+F8.

3. This will open the widget with the search result:

4. You can now close the widget window by clicking the Hide button in the top right corner of 
the application window.

Note that the widget is still running in the background and can be called by pressing the shortcut 
Ctrl+Alt+F8.
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SUMMARY

C You can view an entry by clicking the corresponding term in the Browse list.

C To look up a particular term, enter it into the search text box and press Enter. This will switch the 
Browse list to the Hitlist window and display the search results (if any).

C You can also use placeholder symbols (*) to do wildcard searches.

C By selecting the fuzzy search method you can find terms even if the search string is badly 
misspelled.

C The search is usually only carried out in the selected source language. However, the full text search 
is applied to all fields, e.g. also to definition texts.

C You can search several open termbases sequentially. The results are sorted by termbase in the hitlist.

C You can define filters to limit searching and browsing to a particular subset of the termbase, e.g. all 
entries that contain English definitions.

C SDL MultiTerm Widget allows you to look up terms from any 3rd party application. Once started, 
this widget runs in the background and can be called using the keyboard shortcut Ctrl+Alt+F8.



Chapter

ADDING AND EDITING ENTRIES

This chapter provides examples of how to add and edit 
termbase entries. You will learn how to:

C Correct an existing term

C Add a new entry

C Add descriptive fields and terms in different languages

C Add cross-references and multimedia objects

C Delete entries

5
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CORRECTING A TERM

The hitlist should still show the incorrectly spelled term color cartridge riboon from the previous exercise. 
To correct the term take the following steps:

1. Make sure that the entry that contains the misspelled term color cartridge riboon is displayed in the 
entry window. If this is not the case, click the term in the hitlist.

2. Click the Edit button (or press F2).

3. This will open the entry in the edit mode. Double-click the incorrectly spelled term and 
change it to color cartridge ribbon.

4. Press Enter to confirm the correction.

5. Save the corrected entry by clicking the Save button (or press F12).

ADDING A NEW ENTRY

Let us assume that you would like to add a new entry for the term wall socket. To do this take the following 
steps:

1. Click the Add New button (or press F3).
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2. This opens the edit mode with empty fields in which you can enter the terms in the different 
languages. To add the English term double-click the empty field below the label English.

3. Type the term wall socket, then confirm with Enter.

4. Repeat the above procedure to enter the French term, which is prise de courant. 

5. Then enter the German term, which is Steckdose.

NOTED
You do not need to fill in all languages.

TIPE
You can use the Tab key to jump to the next language. Make sure that you confirm the last term by 
pressing the Enter key before saving the entry.
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6. Save the new entry by pressing F12. The newly created entry should now look as shown 
below:

ADDING MORE INFORMATION TO THE ENTRY

Let us assume that you would like to add some more information to the new entry. 

Adding a Term in Another Language
For example, you would like to add the Spanish translation for wall socket. To do this take the following 
steps:

1. Press F2, which will re-open the newly created entry in the edit mode.

2. Double-click the empty field below the label Spanish and enter the Spanish translation, i.e. 
toma de corriente. Then confirm the new term with Enter.

Adding a Synonym
Let us assume that you would like to enter an English synonym, i.e. wall plug. To do this take the following 
steps:

1. Click the arrow button next to the label English.
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2. This opens a dropdown menu, in which you click Term.

3. This, in turn, opens a new (empty) term field, in which you enter the synonym, i.e. wall plug. 
Confirm the new term by pressing Enter.

Adding a Status Value
Let us assume that you want to indicate that wall socket is your preferred term. The sample termbase offers 
a field called Status, which can be used to add this type of information.

1. Click the arrow button next to the term wall socket.

2. This opens a dropdown menu, from which you select the Status field.

3. This will insert a dropdown list with three values below the term. Select the Preferred value 
from the list, then press Enter to confirm.



Adding  and  Ed i t ing  Ent r i es5

5-6     SDL MULTITERM 2014
SDL plc Confidential. Copyright ¤�2013 SDL plc.

NOTED
Status is a so-called picklist field. This means that it allows you to pick one of several pre-defined 
values. In the next section you will learn how to add information into a free text field.

Adding a Notes Field
Let us assume that you want to add some additional information to the English term wall socket, i.e. a note. 
To do this take the following steps:

1. Click the arrow button next to the term wall socket.

2. This opens a dropdown menu, from which you select the Notes field.

3. This, in turn, opens an empty text field, in which you type the following text: Plug the power 
cord into the wall socket. Then press Enter to confirm.
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Adding a Cross-reference
Note that the text in the Notes field contains the term power cord. Let us assume that you know that power 
cord occurs as a term in another entry. Let us also assume that you want to create a cross-reference to link 
the entry you are currently editing to the existing entry (i.e. the one that contains power cord as a term). To 
do this take the following steps:

1. Highlight power cord within the Notes field text.

2. Click the right mouse button. This will open the Manage a Cross-reference box.

3. If you also highlighted the trailing white space after power cord, remove it in the To term text 
field and then click Search. This will display power cord in the Hitlist.

4. Then click Create to create the reference.

5. Note that the string power cord now has the typical hyperlink formatting (i.e. blue and 
underlined).

6. Use the Save button to save the entry.

7. Now that the entry has been saved you can test whether the cross-reference works. Click the 
hyperlink in the Notes field, i.e. power cord.
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8. This will open the entry that contains the referenced term in a new entry tab. (You can easily 
switch back to the previous entry by clicking the wall socket tab. However, do not do this for 
now, because we still need the power cord entry for another exercise.)

FOR MORE INFORMATION
V

Adding a Cross-reference to another Entry

TIPE
You can close an entry tab by pressing Ctrl+F4.

Adding a Picture
Let us assume that you have an image file illustrating what a power cord looks like on your hard disk. You 
want to add this image file to the currently displayed entry. To do this take the following steps:

1. Press F2 to switch to the edit mode.

2. Click the arrow button next to the term power cord and select Illustration from the context 
menu.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Working_with_Termbase_Entries/Creating_New_Termbase_Entries/Add_a_Cross_Reference_to_an_Entry.htm
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3. Click the Browse button next to the empty Illustration field.

4. Browse to the folder that contains the image file, i.e. ..\Sample Files\Termbases.

5. Select the file cord.jpg by double-clicking it. Note that the name and path of the image file has 
been entered into the Illustration field. 

6. Press Enter to confirm. Note that the image is not displayed yet.

7. Press F12 to save the entry.

8. After saving the entry the image is shown below the term.

FOR MORE INFORMATION
V

Attaching a Multimedia File

DELETING ENTRIES

Let us assume that you want to delete your newly created entry. To do this take the following steps:

1. Click the entry tab labeled wall socket to switch to the corresponding entry.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Working_with_Termbase_Entries/Creating_New_Termbase_Entries/Attach_a_Multimedia_File.htm
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2. Then click the Delete button (or press Shift+Del).

3. Confirm the delete operation by clicking Yes.

NOTED
You need to confirm deletion of the entry, because deleted entries cannot be restored.

Before you go to the exercise in the next chapter switch to the File tab, and then click Close Termbase to 
close the current termbase.

SUMMARY

C To add a new entry press F3, or use the corresponding button.

C To edit an existing entry press F2, or use the corresponding button.

C When editing an entry you can correct the content of fields, add new fields, etc.

C By highlighting and right-clicking a string in a descriptive text field you can link it to another term 
in the termbase.

C You can also add multimedia fields and select a multimedia file, e.g. an image.

C To save a new or edited entries press F12, or use the corresponding button.

C By pressing Shift+Del you can delete an entry. This operation cannot be undone.



Chapter

CREATING TERMBASES FROM
EXCEL GLOSSARIES

In this chapter you will learn how to:

C Convert a glossary file in Excel format into an SDL 
MultiTerm termbase

6
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ABOUT CONVERTING EXCEL GLOSSARIES

SDL MultiTerm comes with an additional product called SDL MultiTerm Convert, which allows you to 
convert, for example, Excel glossaries to SDL MultiTerm XML format. This XML format then be imported 
into a termbase.

PREPARING YOUR GLOSSARY FOR CONVERSION

In your sample files folder, i.e. ..\Sample Files\Converting_Glossaries, you find the glossary.xlsx sample file. 
When opened in Microsoft Excel the glossary looks as shown below:

Note that this file already fits the requirements for converting into SDL MultiTerm XML format, i.e.:

C The terms for each language and the values of the descriptive field (i.e. Subject) are listed in separate 
columns.

C The column headers contain the label of each language field and the descriptive field. It is 
important that the column headers match the names that the fields will have in the SDL MultiTerm 
termbase.

CONVERTING THE MICROSOFT EXCEL FILE

Specifying the Input Format and File
To convert the Microsoft Excel glossary take the following steps:

1. First, make sure that the file to convert is NOT open in Microsoft Excel.

2. Launch SDL MultiTerm Convert through Start -> All Programs -> SDL -> SDL MultiTerm 
2014. Then click the SDL MultiTerm 2014 Convert application icon.

3. This will open SDL MultiTerm Convert, which is a wizard application. On the first page of 
the wizard, click Next to continue. On the following page click Next again.
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4. On the Available conversion options page select Microsoft Excel format from the available 
input formats, then click Next.

5. On the Specify Files page you select the file to convert. Click the Browse button and select 
the file glossary.xlsx from your sample files location (i.e. ..\Sample Files\Converting_Glossaries) 
by double-clicking it. Then click Next.

NOTED
The other text fields will be filled in automatically. These contain the names of the output file paths, 
most importantly the XML output file, which we will later import into a termbase.
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Specifying the Termbase Fields
1. On the Specify Column Header page, the field names from the column headers in the selected Excel 

file are shown in the Available column header fields list. On this page you need define which 
column headers should be processed as language fields, and which ones contain additional 
(descriptive) information. 

2. Start with the Subject field. Make sure that this field is highlighted in the Available column 
header fields list. 

3. The Subject column contains descriptive information (i.e. no terms), therefore the 
Descriptive fields radio button, which is already pre-selected, applies here. Just change the 
value in the dropdown list below from Text to Picklist.

NOTED
The data type Text is used for fields that allow for free text, e.g. a definition, note, example, etc. When 
you have a limited number of values (e.g. only a limited number of clients), then use the data type 
Picklist. This is the likely data type for Subject, as a Subject is usually associated with a limited set of 
values, e.g. general, politics, science, etc.
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4. Continue with the other columns, i.e. English and German. Let us assume that the terms 
listed in the English column should be stored as English (United Kingdom) in the termbase. 
To do this make sure that English is selected in the Available column header fields list.

5. Then click the Language field radio button, as English is a language, not descriptive 
information.

6. From the dropdown list below Language field select English (United Kingdom).

7. Repeat the above step for German, which needs to be assigned to German (Germany). 

8. Click Next to continue.

Specifying the Entry Structure
1. Descriptive information can be assigned to the entry level (i.e. the top level), if they refer to the entry 

as a whole, i.e. to all terms contained in the entry. Descriptive fields can also be assigned to the term 
level, if they refer only to a particular term. Let us assume that the Subject field value should always 
refer to the whole entry.
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2. Highlight Subject in the Available descriptive fields list and select Entry level in the Entry 
structure box. Then click the Add button.

3. Note that the Subject field has now been added under Entry level and therefore above the 
languages. Click Next to continue.

Starting the Conversion
1. On the Conversion settings summary page click Next.

2. This will start the conversion. Wait for the progress bar to indicate that the conversion is 
finished. 

3. Proceed by clicking Next and then click Finish.

4. Take a quick look at the sample folder that contains your glossary.xslx file.  
SDL MultiTerm Convert has created the following files:

C glossary.xdt: this is the termbase definition file from which we will create a new (empty) 
termbase
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C glossary.mtf.xml: this is the termbase content, which we will import into the termbase (which 
we are going to create in the next step)

FOR MORE INFORMATION
V

About SDL MultiTerm Convert

CREATING A NEW TERMBASE

Start SDL MultiTerm if it is not running through Start -> All Programs -> SDL -> SDL MultiTerm 2014 -
> SDL MultiTerm 2014 Desktop.

Creating the Termbase File
To start creating the new termbase take the following steps:

1. Switch to the File tab, and then select the New -> Create Termbase.

2. This opens the Save New Termbase dialog box, in which a location and a default name for 
the new termbase is already suggested, i.e. New Termbase.sdltlb.

3. Replace the suggested termbase file name with glossary.sdltb, then click Save.

Loading the Termbase Definition
1. This opens the Termbase Wizard. On the first screen of the wizard just click Next to continue.

2. We will now create the new termbase based on the glossary.xdt termbase definition, which 
SDL MultiTerm Convert has created. To select this termbase definition click the Load an 
existing termbase definition file radio button.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/SDL_MultiTerm_Convert/About_MultiTerm_Convert.htm
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3. Click the Browse button and select the file glossary.xdt from your sample files location. 

4. Then click Next to continue.

Naming the Termbase
1. On the Termbase Name page, enter a name for your termbase into the Friendly Name text field, e.g. 

User Interface Glossary. 

2. Then click Next to continue.
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Languages and Descriptive Fields
1. The Language Fields page lists the languages taken over from the Excel file. Here you just need to 

click Next to continue.

2. You can also skip the next two pages, i.e. Descriptive Fields and Entry Structure by clicking 
Next twice.

3. On the Wizard Complete page click Finish to create the termbase.

4. Wait a few seconds for the new termbase to be created. Note that the termbase name is 
shown in the application title bar.

FOR MORE INFORMATION
V

About Creating Termbases

Importing the Glossary Content
Note that the newly created termbase is still empty. You need to import the content that you converted 
from the Excel glossary into the termbase. To do this take the following steps:

1. Click the Termbase Management button on the bottom of the Navigation pane.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Creating_New_Termbases/About_Creating_New_Termbases.htm
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2. Right-click Import and then select Process from the context menu.

3. On the first page of the Import Wizard click Browse and select the file glossary.mtf.xml, 
which has been created by SDL MultiTerm Convert, from your sample files folder.

4. Then activate the Fast import check box and proceed by clicking Next.

5. On the following page click Next again.

6. Wait for the progress bar to reach 100%. After all entries have been processed click Next, 
and then Finish.
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7. Switch back to the Terms view, and the terms from the imported entries are now shown in 
the Browse list.

FOR MORE INFORMATION
V

How to Import Termbase Data

SUMMARY

C Glossaries in Excel format can be converted to SDL MultiTerm XML through SDL MultiTerm 
Convert, which is a wizard application.

C The field and language names need to be stated in the first row, i.e. in the column headers.

C SDL MultiTerm Convert generates an *.xdt file, which contains the termbase definition and from 
which a termbase can be created.

C SDL MultiTerm Convert also generates an *.xml file, which contains the actual entries, and which 
can be imported into the termbase.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Importing_Termbase_Data/Perform_a_Termbase_Entry_Import.htm


Chapter

CREATING TERMBASES

This chapter provides an example of how to create a termbase 
from scratch. You will learn how to:

C Add languages to the termbase definition

C Add descriptive fields

C Define the entry structure

7
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CREATING A TERMBASE FROM SCRATCH

First, click Close Termbase on the File tab to close the termbase that you created in the previous chapter. 
There you learned to create a termbase based on an existing termbase definition (XDT) file, which was 
derived from an Excel glossary. In this chapter you will learn how to create a termbase definition from 
scratch.

Selecting the Location and the Termbase File Name
To create a termbase definition from scratch take the following steps:

1. Switch to the File tab, and then select the New -> Create Termbase.

2. In the Save New Termbase dialog box select a location in which the termbase file is to be 
stored, e.g. your sample files folder: ..\Desktop\Sample Files.

3. Note that in the File name text field a default name is suggested for your termbase, i.e. New 
Termbase.sdltb. Overwrite this name with, for example, training.sdltb. Then click Save.

4. This opens the Termbase Wizard. On the first screen of the wizard just click Next to 
continue.

5. On the Termbase Definition page, leave the default option (Create a new termbase definition 
from scratch) selected, and click Next.
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Entering the Friendly Termbase Name
1. On the Termbase Name page enter the name for your termbase into the Friendly Name text field, 

e.g. Training Termbase. 

2. Click Next to continue.

NOTED
The friendly termbase name is a descriptive name, which can differ from the termbase file name. In 
the friendly name you can use characters that are not allowed in a file name, e.g. colons or asterisks.

FOR MORE INFORMATION
V

Termbase Name

Adding Language Fields
Let us assume that you need to create a termbase with the languages English, French, and German. To 
add the termbase languages take the following steps:

1. On the Language Fields page select French from the Languages dropdown list. 

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Creating_New_Termbases/Copy_of_Termbase_Wizard___Termbase_Name.htm
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2. Then click the Add button to add the selected  to the Selected  fields list on the right-hand 
side.

3. Repeat the above steps to add English and German. Then click Next to continue.

FOR MORE INFORMATION
V

 Fields

Adding Descriptive Fields
Descriptive fields allow you to enter additional information to further describe a term or an entry. Let us 
assume that you require two fields, i.e. Client and Notes. To add these fields take the following steps:

1. On the Descriptive Fields page enter Notes into the Field label text field. 

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Creating_New_Termbases/Copy_of_Termbase_Wizard___Index_Fields.htm
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2. Then click the Add button to add the field to the Descriptive fields list on the right-hand side.

3. Repeat the above step to add a field labelled Client.

Defining the Field Properties
By default all descriptive fields are considered free text fields. However, let us assume that you want to 
associate the Client field with a list of predefined values. To do this take the following steps:

1. Highlight the Client field in the Descriptive fields list and click the Properties button.
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2. This opens the Properties dialog box. Select Picklist from the Data type dropdown list. This 
will enable Picklist field below the dropdown list and a set of buttons that allow you to add, 
delete and move picklist values.

3. Click the button with the green plus icon. This will add a line with a blue background in the 
Picklist field.

4. Double-click the line and enter a value, e.g. BorgComNetworks.
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5. Repeat the above steps to add another value, e.g. FixTheMix.Com. Then click OK to close the 
Properties dialog box.

6. Click Next to continue.

FOR MORE INFORMATION
V

Descriptive Fields

Defining the Entry Structure
Last, you need to define the entry structure for your termbase. This means the following: descriptive fields 
can occur on the top level, the so-called entry level. Entry-level descriptive fields refer to the whole entry, 
i.e. to all terms in a particular entry. A good example of this is the Client field, because this type of 
information usually applies to the whole entry. Descriptive fields can also occur on the term level. For 
example, a definition, a note, etc. usually refers to a particular term.

Take the following steps to define the entry structure for your termbase:

1. In the Entry structure box on the left-hand side of the screen click on Entry level.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Reference/Wizards/Termbase_Wizard/Termbase_Wizard_Descriptive_Fields.htm
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2. In the Available descriptive fields list highlight the Client field. Then click the Add button.

3. Note that the Client field is now listed under Entry level. Click the Client field in the 
Available descriptive fields list on the right-hand side again to deselect it.

4. The Notes field is supposed to refer to the respective terms of an entry. Therefore, in the 
Entry structure box on the left-hand side select Term level. 

5. In the Available descriptive fields list highlight the Notes field. Then click the Add button.

6. Click Next to continue, then click Finish.
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7. You have now successfully created a new (empty) termbase. Note that the termbase name is 
displayed in the application title bar.

FOR MORE INFORMATION
V

Entry Structure

SUMMARY

C When you create a termbase definition from scratch you add the required languages.

C You can also add the descriptive fields you require, e.g. Notes, Client, etc.

C By default, each descriptive field that you add is a free text field. To change the data type, e.g. to 
picklist, you need to change the field’s properties. This allows you to associate a field with a number 
of pre-defined picklist values.

C Descriptive fields can occur on the entry level (i.e. refer to all the terms in an entry) or can be term-
specific, i.e. refer to a particular term only. 

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Reference/Wizards/Termbase_Wizard/Termbase_Wizard_Entry_Structure.htm
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Chapter

WORKING WITH INPUT MODELS

In this chapter you will learn how to:

C Define an input model to streamline the entry creation 
process

C Use an input model to add a new entry

8
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WHAT ARE INPUT MODELS?

Input models are templates, which you can use to facilitate editing and creating entries. When you added 
a new entry in one of the previous exercises, all languages were offered for editing, even when you only 
needed to fill in some of the available languages. Moreover, in order to add a descriptive field (e.g. Notes), 
you had to manually add a blank field, and then enter the field content. 

When you use an input model, the fields that you require are already included in the form of a template. 
All you have to do is to fill in the fields. It is also possible to define fields as mandatory. Example: when 
you set the Subject field as mandatory, entries cannot be saved if you failed to fill in that particular field.

Therefore, input models offer the following advantages:

C Greater speed

C More consistency, as you can pre-define the fields and the entry structure

FOR MORE INFORMATION
V

About Input Models

CREATING AN INPUT MODEL

In the previous exercise you set up a termbase with three languages. Now we are going to create an input 
model based on the definition of our newly created termbase. The following requirements apply:

C You only need to add terms in two languages, i.e. English and German.

C You want your input model to include a Notes field.

C On the top of each entry a Client field is required. This field should be mandatory.

To crate an input model that fits the above requirements take the following steps:

Naming the Input Model
1. Click the Termbase Management button on the bottom of the Navigation pane. 

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Working_with_Input_Models/About_Input_Models.htm
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2. Right-click the Input Models icon below Training Termbase, then select the Create 
command from the context menu.

3. On the first page of the Input Model Wizard click Next to continue.

4. On the Input Model Name page enter a name for your input model into the Name field, e.g. 
English - German Model. Then click Next.

Adding an Entry-Level Field
1. On the Input Model Definition page, right-click the item Entry level. This opens a list with the 

languages that are available in the termbase. 
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2. From the list click Client and then press Enter. This will add the Client field below Entry 
level.

3. Let us assume that the Client field needs to be mandatory. This means that it should not be 
possible to save an entry without selecting a value for this field. To do this activate the 
Mandatory check box while the Client field is still highlighted.
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Adding Languages
1. Now add the two languages that your input model should include, i.e. English and German. Right-

click Entry level again. While keeping the Ctrl key pressed select German and English. Then press 
Enter.

2. Now add a Notes field for the term of each language. To do this right-click Term below 
German. Then select Notes from the list and confirm by pressing Enter.

3. Repeat the above step for English. The Notes field should NOT be mandatory, i.e. leave the 
settings for this field unchanged.

4. Close the wizard by clicking Next and then Finish.

FOR MORE INFORMATION
V

C Creating an Input Model

C Defining Input Models

ADDING A NEW ENTRY BASED ON THE INPUT MODEL

Now that you have defined the input model let us use it to add a new entry. Let us assume that you want 
to add the term mouse and its translation to your termbase. To add a new entry based on your newly created 
input model take the following steps:

1. Click the Terms button on the bottom of the Navigation pane.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Working_with_Input_Models/Create_a_New_Input_Model.htm
http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Working_with_Input_Models/Defining_Input_Models.htm
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2. Select your newly-created input model from the Input model dropdown list.

NOTED
It is important to select the input model BEFORE you add the entry.

3. Press F3 to add a new entry. This will open the edit mode, which already contains the fields 
that you defined in your input model.

4. Double-click the empty field next to Client. This will open the list of available values. Click 
the check box next to the first value, then press Enter.

5. Press the Tab key. This will automatically open the German term field. Enter the term Maus.
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6. Press Tab again. This will open the Notes field. Enter some descriptive text, e.g. Mit der 
Tastatur zu arbeiten ist effektiver als mit der Maus. Then press Tab to continue.

7. Now enter the English term, i.e. mouse.

8. Press Tab to go down to the Notes field and enter e.g. Using the keyboard is more efficient than 
using the mouse. Close the field with Enter.

9. Save the entry with Edit -> Save.

As you have seen in this exercise, adding an entry using an input model can be a lot faster, as you can just 
use the Tab key to jump to the next field to fill in.

SUMMARY

C Input models can significantly streamline the entry creation/editing process, as they provide a 
template with fields that you can fill in.

C Fields can be defined as mandatory, i.e. you cannot save an entry unless you fill in this particular 
field.

C Before adding an entry you need to select the input model that you want to use.

C Within the input model you can use the Tab key to go from field to field.



Chapter

EXTRACTING TERMINOLOGY

In this chapter you will learn how to:

C Set up a terminology extraction project

C Extract bilingual terminology from a translation memory 
file in TMX format

C Review the extraction result

C Export the extraction result to a termbase

9
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WHAT IS TERMINOLOGY EXTRACTION?

Terminology extraction provides a fast and efficient way to fill your termbase with relevant terminology. 
You can extract terminology from existing monolingual or bilingual documents (e.g. translation 
memories). This allows you to quickly add relevant terminology to your termbase. You can, for example, 
process documents that were translated in the past in order to fill your termbase with customer/project-
specific terms, which can then be leveraged in future translation projects.

For terminology extraction, SDL offers SDL MultiTerm Extract, which is a separate product. The following 
exercise can only be done if you have installed SDL MultiTerm Extract on your PC.

PERFORMING A BILINGUAL TERMINOLOGY EXTRACTION

For this exercise we are going to assume the following: you have a translation memory (TM) export, which 
contains segments that were translated in the past. Now you want to extract relevant terminology from the 
bilingual TM and import the terms into your termbase.

NOTED
For this exercise we are using a very small TM export file, which only contains a few dozen segments. 
Terminology extraction works better on larger files, as they provide a better statistical basis for the 
heuristic-based terminology extraction.

Starting SDL MultiTerm Extract
To start the application take the following steps:

1. Click the Windows Start button, then select All Programs -> SDL -> SDL MultiTerm 2014, and click 
the SDL MultiTerm Extract 2014 application icon.

2. After SDL MultiTerm Extract has launched, maximize the application window by clicking 
the Maximize button in the top-right corner.

Creating a Bilingual Extraction Project
To set up a bilingual extraction project take the following steps:

1. Select the File -> New Project menu command. This will open the New Project Wizard.

2. Select Bilingual Term Extraction Project.
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3. Enter a project name into the Project Name text field, e.g. Training. Then click Next.

Selecting the Termbase
1. On the next screen click the Choose button to select the training termbase that you created in one of 

the previous chapters. This is the termbase that we will use to import the terminology extraction 
result.
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2. In the Choose Termbase dialog box click the Browse termbase button. Browse for the folder 
that contains your newly created training termbase and select the termbase file training.sdltb 
by double-clicking it. The termbase name should now be listed in the dialog box.

3. Click the termbase name to highlight it, then click OK.
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4. The termbase languages are now listed below the termbase name. The terminology 
extraction will be from English to German. Therefore, make sure that the selected Source 
Language is English(en) and the Target Language is German(de). Then click Next.

Selecting the Project File
1. On the next screen click the Browse button and browse to the folder that contains the sample TMX 

file, which is a small translation memory export, i.e. ..\Sample Files\Extracting_Terminology.

2. Select the file Sample English - German.tmx by double-clicking it. When the file name is 
shown in the Project Files list, click Finish.

Running the Extraction
After selecting the project file you will be prompted to run the extraction. Take the following steps:
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1. Confirm the prompt by clicking Yes, which will start the extraction process.

2. Wait a few seconds for the extraction to finish, then click OK.

3. The extraction result is shown in a bilingual table, which looks as shown below:

Verifying the Extraction Result
The next step is to verify the extraction result. This implies going through the list of extracted terms, and 
confirm the term pairs and edit the extracted terms as required.

To do this take the following steps:

Validating a Term Pair

1. When you find that the source and target terms are correct, then you can validate them by clicking 
the check boxes next to the source and target terms. As the first term pair is correct, click the 
corresponding check boxes.

2. Then use the Down key to go to the next term pair.

Editing a Term

The second suggested term pair is almost correct. However, in the target language the plural form is used 
whereas the source language contains the term in its singular form.

To change the target term to the singular form take the following steps:
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1. Double-click inside the target term.

2. Overwrite the plural form with the singular form, i.e. Benutzerwörterbuch.

3. Finally validate both source and target term by clicking the corresponding check boxes.

4. Move down to the next term pair, which is actually correct. Therefore validate both terms. 
Then go down to the next term.

Adding a Target Term

For the next source term the extraction was unable to identify the target term, i.e. the target column is 
empty.

You can manually add the target term. SDL MultiTerm Extract can help you research the correct term 
using the so-called concordance search. Take the following steps:

1. While the source term dialog box is highlighted right-click it, then select the Concordance command 
from the context menu.

2. Look at the Concordance window in the lower-right corner of the application. This window 
lists all the sentences in which the source term was found.

3. Let us assume that you have identified the target term Dialogfeld as the correct translation. 
Select this term by double-clicking it. 

4. Then click the right mouse button and select Add As Translation from the context menu.
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5. Note that the selected target term has been added as a validated term to the extraction list. 
Moreover, the target term is now highlighted in the Concordance window.

6. Click the check box next to the source term dialog box to validate it.

At this point we will stop verifying the extraction result. You may use your newly acquired knowledge to 
verify the remaining term candidates yourself.

Exporting the Extraction Result to the Termbase
To export the validated terms to the termbase take the following steps:

1. Select the File -> Export menu command. 

2. This opens the Export Wizard. On the first screen of the wizard click Next to continue.
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3. On the next screen leave the Export to the project termbase default option selected and click 
Next.

4. On the next screen select Only Validated from the Filter dropdown list. This ensures that 
only the terms that you validated (i.e. checked) will be imported into the termbase. Then 
click Next.

5. Skip the two following screens by clicking Next twice. Finally click Finish. 

6. When prompted to save the export definition for later use click No.
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7. Wait a few seconds for the export to finish then click OK.

8. When prompted to remove the non-validated terms from the project click Yes. This will 
remove any terms from the extraction list that you did not validate.

NOTED
Removing non-validated terms is useful when you are certain that you have finished the extraction 
project. If you plan to continue to validate terms (e.g. the next day), then do not remove any non-
validated terms from the project.

Switch back to SDL MultiTerm 2014. Click the Refresh View button on the View tab. This will show the 
newly imported terms in your termbase.

SUMMARY

C Terminology extraction allows you to scan bilingual documents (i.e. translation memories) for 
suitable term candidates.

C When setting up a bilingual terminology extraction project, select the termbase into which the 
extracted terms should be imported and the translation memory (or translation memories), e.g. in 
TMX format.

C The extraction result will be presented in the form of a bilingual table.

C You can validate terms by clicking the check boxes next to them.

C You can modify terms by double-clicking and editing them.

C Using the concordance search you can display all segments that contain the selected term. This 
helps you see the term in context and identify suitable target terms.

C The extraction result can then be imported into the selected termbase. You can apply a filter to make 
certain that only validated terms are imported into the termbase.



Chapter

EXPORTING TERMBASES

In this chapter you will learn how to:

C Export a termbase to an XML file

C Generate a bilingual word list and a Microsoft Word RTF 
dictionary from a termbase

C Run a filtered export

10
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ABOUT EXPORTING TERMBASES

Exporting termbases can be useful for the following reasons:

C You want to create a backup of a termbase, e.g. to give it to other users for import into their 
termbases

C You want to generate a printable file from a termbase, e.g. in Microsoft Word or Microsoft Excel 
format

Exporting termbases can be a way of providing terminology data to users who are not equipped with SDL 
MultiTerm.

Before running the export operations close the current termbase (select the File tab, then click Close 
Termbase). Then open the Hardware Termbase again.

RUNNING AN XML EXPORT

The underlying format used by SDL MultiTerm is XML. Therefore, you can easily export the content of a 
termbase to an XML file. This can be useful, for example, if you want to back up your termbase to an 
external file. You can also send the XML export file to other users (e.g. external translators), who can then 
import the XML into their termbases. To run an XML export take the following steps:

1. Click the Termbase Management button on the bottom of the Navigation pane.

2. Click the Export icon below the termbase name.
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3. Note that the available export definitions are now listed on the right-hand side. Right-click 
Default export definition and select the Process command from the context menu.

4. On the first page of the Export Wizard click the button Save As and select a location and 
name for your export file, e.g. your desktop. As file name you can enter, for example, XML 
Export. Then click Next.

5. On the next page, wait for the progress bar to reach 100%. This means that the export has 
been processed successfully. Click Next and then Finish to close the Export Wizard.

6. Take a look at the location in which the XML export file has been created. You can open the 
file in your browser by double-clicking it. Note, however, that XML is not suitable for reading 
or printing.
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GENERATING A BILINGUAL GLOSSARY FROM THE
TERMBASE

Let us assume that you want to generate a bilingual word list. This can also be useful, if you want to give 
a terminology list to an external translator who does not have SDL MultiTerm. You can also print such a 
list and use it e.g. for an interpreting job. To generate a bilingual word list take the following steps:

1. Note that type of export only takes into account the terms from the selected source and target 
language. All other languages will be ignored. Switch back to the Terms view, and make sure that 
English is selected as source . Then select German as target .

2. Now switch to the Termbase Management view, then click Export below the termbase name.

3. Right-click HTML export definition and select the Process command from the context 
menu.

4. On the first page of the Export Wizard click the button Save As, and select a location and 
name for your export file, e.g. your desktop. As file name you can enter e.g. Glossary. Then 
click Next.

5. On the next page wait for the progress bar to reach 100%. This means that the export has 
been processed successfully. Click Next and then Finish to close the Export Wizard.
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6. Take a look at the location in which the export file has been generated. Double-click the 
export file to open it in your Web browser. The export result should look as shown below:

NOTED
This export format does not include any descriptive fields. Only the terms of the selected 
source/target language are exported.

TIPE
You can also open the HTML export file directly in Microsoft Excel.

GENERATING A DICTIONARY FROM YOUR TERMBASE

Let us assume you want to generate a dictionary from your termbase, e.g. for print purposes. To create a 
dictionary take the following steps:

1. Make sure that the available export definitions are still listed.

2. On the right-hand side, right-click Word Dictionary export definition and select the Process 
command from the context menu.

3. On the first page of the Export Wizard click the button Save As, and select a location and 
name for your export file, e.g. your desktop. As file name you can enter e.g. Dictionary. 
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4. At this point let us assume that you only want to export entries that contain an English 
definition. Note that in one of the previous chapters you defined a filter with exactly this 
criterion. All you need to do is select the pre-defined filter. To do this check the box Apply 
filter and make sure the pre-defined filter Has English Definition is selected in the dropdown 
list.

5. Click Next to run the export.

6. On the next page wait for the progress bar to reach 100%. This means that the export has 
been processed successfully. Click Next and then Finish to close the Export Wizard.

7. In Windows Explorer go to the location of the export file. Double-click the export file to open 
it in Microsoft Word. The export result should look as shown below:

NOTED
The Word Dictionary export definition only takes the currently selected source/target language into 
account. 
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FOR MORE INFORMATION
V

C About Export Definitions

C About the Export Wizard

SUMMARY

C Each termbase comes with a set of pre-defined export definitions, which allows you to export the 
termbase content into a number of different file formats, e.g. XML, HTML, RTF.

C XML is mainly used for backup purposes, as it is the only format that can be directly imported into 
a termbase.

C HTML exports contain the terms in two selected languages. These exports can be used, for example, 
to generate bilingual glossaries.

C RTF exports can be used to generate printable dictionaries.

C You can apply pre-defined filters during an export to limit the export to a subset of the termbase.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Exporting_Termbase_Data/About_the_Export_Wizard.htm
http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Creating_and_Maintaining_Termbases/Exporting_Termbase_Data/About_Export_Definitions.htm


Chapter

MAINTAINING TERMBASES

This chapter provides a practical example of how to keep a 
termbase lean and efficient. You will learn how to:

C Search for duplicate terms

C Merge entries

C Create read-only copies of a termbase

11
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HANDLING DUPLICATE TERMS

From time to time it may be necessary to maintain your termbase to keep it lean and efficient. For 
example, it can happen that your termbase for duplicate terms, which clutter the termbase unnecessarily.

However, duplicate terms are not always redundant. The same word in one language can have different 
meanings and different translations. Just take the English word well as an example. In this case the same 
term can occur on several entries and is not redundant as the corresponding entries stand for completely 
different concepts.

Searching for Duplicate Terms
Let us check whether our sample termbase has any potential duplicates. To do this take the following steps:

1. First, make sure that English is selected as source language and that you are in the Terms view.

NOTED
The duplicates search (like most other search types) is performed in the selected source language.

2. Click the Advanced Search button, and then select Search for Duplicate Terms.

3. The hitlist shows that the term interface exists twice in the termbase. Note that the numbers 
behind the terms in the hitlist are the unique entry ids. The entry that contains the first 
occurrence of the duplicate term is shown in the Entry window on the right-hand side.

Comparing the Entries
Now you want to take a look at the second entry to check whether this term is redundant or not. To do this 
take the following steps:

1. Go back to the Browse list by clicking the corresponding tab.

2. Note that the two interface terms are shown in the Browse list. Click the first occurrence of 
the term.
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3. Then keep the Ctrl key pressed while clicking the second occurrence of the term. This will 
open both entries in separate entry tabs.

4. You can easily switch between the two entries by clicking the corresponding tab on top of the 
Entry window. 

If you compare the two entries, you will note that the first entry contains the term interface and its 
translations in German, French, and Spanish. The second entry contains the Chinese, Japanese, and 
Portuguese translations for the same term. 

It makes, of course, sense to consolidate all these terms in one entry, as they belong to the same concept. 
To merge the information of both entries into one entry take the following steps:
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1. Click the Merge button (or press F9).

NOTED
Make sure that no further entries are open at the same time, as the content of those entries would 
also be merged. You can close entries tabs by selecting the corresponding tab and then pressing 
Ctrl+F4.

2. Confirm the merge operation by clicking Yes. Note the currently displayed entry now 
contains all the languages.

3. To save the merged entry press F12.

4. Merging all languages in a single entry has NOT deleted the other entry, which has now 
become redundant. Therefore, we can safely delete it. To do this click the tab of the other 
entry.

5. Delete this entry by pressing Shift+Del.

6. Confirm deletion of the entry with Yes.

FOR MORE INFORMATION
V

Search for Duplicate Terms

CREATING A READ-ONLY COPY OF A TERMBASE

Sometimes you may want to forward your termbase to other users. In that case it is enough to just send 
the corresponding *.sdltb file. However, you may not want the recipient of your termbase to be able to 
modify or export the content of the file.

In that case you can encrypt your termbase before sending it to another user. To do this take the following 
steps:

1. First open your Windows Explorer, and go to the folder in which your termbase file is located, i.e. 
..\Sample Files\Termbases\Hardware.sdltb.

2. Then create a copy of the *.sdltb file.

NOTED
Make certain that you run the encryption on a copy of the *.sdltb file, because once the termbase file 
is encrypted you can no longer edit it yourself.

3. Open the copy of the termbase in SDL MultiTerm.

4. Switch to the Termbase Management view.

http://producthelp.sdl.com/SDL%20MultiTerm%202009/client_en/Accessing_Termbases/Searching_For_Termbase_Entries/Search_for_Duplicate_Terms.htm
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5. Right-click the termbase name and select the Reorganize command from the context menu.

6. In the Reorganize Termbase dialog box select the options Encrypt termbase and Set 
termbase to read-only.

TIPE
Optionally, you can also set an expiry date for your termbase. That way you can make certain that no 
one uses the termbase after the specified date.

7. Now click OK to run the encryption. Once the message Done appears, click Next to 
continue.

8. On the following screen you will see a summary of the process. Click Finish to close the 
dialog box.

You can now forward the encrypted *.sdltb file to other users of SDL MultiTerm. 

NOTED
Note that it is sufficient to just send out the *.sdltb file. The *.mtf and *.mdf files contain the search 
languages, and will be created automatically once the *.sdltb file is opened on another PC.
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SUMMARY

C In the course of time a termbase may accumulate potential duplicate entries. These can be 
homonyms (i.e. words that have different meanings, thereby expressing different concepts) or the 
same term with the same meaning can be found on several entries. In this case it is redundant.

C SDL MultiTerm allows you to search for any potential duplicates, which are then shown in the 
Hitlist for the selected source language.

C Entries can be opened in separate entry tabs. To do this click the corresponding terms in the Browse 
list while keeping the Ctrl key pressed.

C You can delete redundant entries.

C You can merge entries, thereby making certain that all useful information is consolidated in one 
entry.

C Through the Reorganize feature you can make encrypt a termbase and make it read-only to prevent 
other users from editing it or exporting its content.



Chapter

ACCESSING TERMBASES FROM
SDL TRADOS STUDIO

This chapter provides an overview of how SDL MultiTerm 
integrates into the translation environment SDL Trados Studio. 
You will learn how to:

C Open a document for translation in SDL Trados Studio

C Select a termbase from SDL Trados Studio

C Look up and insert terms while translating

C Add new entries from SDL Trados Studio

12
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GENERAL INFORMATION ON SDL TRADOS STUDIO

SDL Trados Studio offers functionality for translating, reviewing, and managing translation projects. 
While translating you can add and edit termbases entries directly from SDL Trados Studio. Moreover, SDL 
Trados Studio automatically scans each source segment for known terms. This feature is called active 
terminology recognition. Active terminology recognition allows you to easily insert target terms from the 
termbase into your translation.

Using Termbases from SDL Trados Studio

NOTED
You can only follow this exercise if SDL Trados Studio is installed on your system.

Starting SDL Trados Studio
1. Start SDL Trados Studio through Start -> All Programs -> SDL -> SDL Trados Studio 2014, and click 

the SDL Trados Studio 2014 application icon.

2. If you are starting SDL Trados Studio for the first time, you need to enter your user name 
and your e-mail address. Then click Next.

3. If you are starting SDL Trados Studio for the first time, you will also be prompted to select a 
profile. Keep the Default profile selected and click Next.

4. On the following page you can simply proceed by clicking Next again, then click Finish.

Opening a Document for Translation
To open a document for translation take the following steps:

1. Click the Translate Single Document button on the Welcome screen.

2. Browse to the folder where the sample document is stored, i.e. ..\Sample Files\Documents, 
and select the file PhotoPrinter.doc by double-clicking it.

3. In the Open Document dialog box make sure  that English (United States) is selected in the 
Source Language dropdown list.
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4. Then select your preferred target language from the Target Language dropdown list.

NOTED
Make sure that you select a target language that is covered by the sample termbase. At the time of 
writing the sample termbase contained the following languages: English, German, French, Spanish, 
Portuguese, Chinese, and Japanese.

Selecting a Termbase
1. To select your termbase click the Advanced button in the lower left corner of the dialog box.
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2. On the left-hand side of the Project Template Settings dialog box select Language Pairs -> All 
Language Pairs -> Termbases. Then click the Add button.

3. In the Select Termbases dialog box click the Browse button and browse to the location where 
your sample termbases are stored, e.g. ..\Sample Files\Termbases.

4. Select the termbase file Hardware.sdltb by double-clicking it, then click OK to close the Select 
Termbases dialog box.

5. A message box will open to inform you that the languages (i.e. languages) have been 
mapped to the language pair of our sample translation project. Click OK to close the 
message.

6. Then click OK to close the Project Template Settings dialog box. Click OK again to open the 
document in SDL Trados Studio.
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NOTED
When opening a document for translation you would normally select a translation memory (TM). 
However, in this exercise we will focus only on using a termbase. Creating and using TMs is covered 
in the dedicated SDL Trados Studio training courses.

FOR MORE INFORMATION
V

How to Add or Remove a Termbase

Translating the Document in the Editor
The document is now shown in the side-by-side editor. On the left-hand side you see the English source 
segments. During translation you enter the target segments into the (empty) column on the right-hand 
side.

Using Active Terminology Recognition

Note that in the first source segment, the term photo printer is highlighted with a red bracketed line. This 
indicates that this term has been found in the selected termbase. In the Term Recognition window in the 
top right corner you see the term and its translation.

To translate the first segment take the following steps:

1. Make sure that the cursor is placed in the target cell next to the first source segment and start typing 
your translation. As soon as you type the first letter of the target term (e.g. in German F for 
Fotodrucker), the correct target term is suggested automatically.

2. Press Enter to insert the suggested target term into your translation.

3. After you have finished translating the first segment press Ctrl+Enter to move to the 
following segment.

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Projects_View/Managing_Projects/Editing_Project_Settings/OpenRe_TB.htm
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4. In the second segment two terms have been recognized, i.e. photo printer and color cartridge. 
Start translating this segment. Again, when you type the first letter of one of the suggested 
target terms, a list opens from which you can select the correct target term.

NOTED
If the list contains more than one term, you can use the Up and Down keys on your keyboard to select 
the target term that you want to insert.

NOTED
You may have to adapt the terms that are suggested by the termbase to make them fit the current 
context, e.g. when an inflected or plural form is required.

5. Finish translating the second segment, then press Ctrl+Enter to go to the next segment.

6. In the third segment three terms have been recognized, i.e. power cable, USB, and photo 
printer. Now we would like to show you an alternative way inserting target terms into your 
translation. Instead of typing the first letters of a suggested target term, you can also use the 
keyboard shortcut Ctrl+Shift+L. This will open a list with all the terms found in the current 
source segment.

7. You can use the Up and Down keys on your keyboard to select a target term in the list. Then 
press Enter to insert the required target term into your translation. Finish translating the 
third segment, and press Ctrl+Enter to proceed to the last segment.

FOR MORE INFORMATION
V

Term Recognition Window

Viewing the Full Termbase Entry

The last segment also contains the known term photo printer. Let us assume that you would like to see the 
full termbase entry, i.e. not only the source and target term. You can do this directly from SDL Trados 
Studio:

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/TermRecWin.htm
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1. In the Term Recognition window highlight the term photo printer, then click the right mouse button. 

2. Select View term details from the context menu. This will open the Termbase Viewer 
window next to the editor. This window shows the full entry and additional information, i.e. 
descriptive fields and multimedia objects (if available).

TIPE
Move the mouse pointer to the border of Termbase Viewer window and then resize it as required. 

FOR MORE INFORMATION
V

Termbase Viewer Window

Close the Termbase Viewer window by clicking the Close button.

Then finish translating the current segment and confirm it by pressing Ctrl+Enter.

 

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Screen_Layout/Editor_View/EVTheEditViewWindowsTerminology.htm
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Adding an Entry to the Termbase
Take a look at the next segment: the term ventilation is not included in the termbase. Let us assume that 
you expect you will have to translate this term more often in future documents. It would therefore be a 
good idea to add it to the termbase on the fly during translation. To do this take the following steps:

1. Translate the last segment and make sure your translation contains the proper translation for 
ventilation (German: Belüftung).

2. Highlight the source term ventilation and the target term by double-clicking the terms.

3. Then click the right mouse button, and select Add New Term from the context menu.

4. Note that the new term pair is now shown in the Termbase Viewer window next to the editor.

5. Let us assume that would like to add a Subject value to the suggested entry. To do this click 
the arrow button on the top of the entry and select Subject from the context menu.

6. Click the check box next to IT and Telecom. Then press Enter.
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7. To save the new entry in the termbase click the Save this Entry button.

8. Note that after adding the entry the term ventilation is highlighted with a red bracketed line 
in the source segment, as it has become a known term.

9. Confirm the last target segment with Ctrl+Enter.

10. Close the Term Recognition window.

FOR MORE INFORMATION
V

How to Add Terms to a Termbase

Searching the Termbase from SDL Trados Studio
You can also search for terms that are not in the document. To do this follow the steps below:

1. Click the Termbase Search tab on the bottom of the Term Recognition window.

2. Then enter your search term, e.g. true image into the search text field of the Termbase Search 
window. Press Enter to execute the search. 

http://producthelp.sdl.com/SDL%20Trados%20Studio/client_en/Edit_View/Terms/EVTermbaseActionsAdd_Terms_to_a_Termbase.htm
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3. The results will be shown directly in the Termbase Search window of SDL Trados Studio. 

FOR MORE INFORMATION
V

Termbase Search Window 

SUMMARY

C You can select one or several termbases for searching and editing from the SDL Trados Studio 
translation environment.

C When you have selected a termbase, SDL Trados Studio will automatically search the current 
segment for any known terms (active terminology recognition). If terms are found, you can insert 
the target term directly into your translation either by typing the first letter and pressing Enter.

C You can add new terms to the termbase by highlighting the source/target terms in the document 
and by selecting the Add New Term command from the context menu.



Chapter

SDL MULTITERM ONLINE

This chapter provides general information on accessing 
termbases through a Web browser.

13
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ABOUT SDL MULTITERM ONLINE

SDL MultiTerm Online allows you to access termbases using a Web browser (i.e. Microsoft Internet 
Explorer or Mozilla Firefox). To do this you do not even have to have SDL MultiTerm installed. Note that 
only server termbases can be provided through SDL MultiTerm Online, i.e. not the file-based termbases 
that you have been using throughout this training.

If you have access to an SDL MultiTerm Online server, take the following steps:

1. Open your Web browser and enter the server URL, for example http://www.multiterm.com.

2. Then enter your user name and password, and click Login.

3. After the log-in the available termbases are displayed. Activate the check box next to the 
termbase that you want to access, then click OK.

4. The termbase is then opened in a view that is similar to SDL MultiTerm. On the left-hand 
side you see a browse list with the terms from the selected source language.

5. Make sure that the required language pair is selected, e.g. English as source and French as 
target language.

6. Enter the term accounting into the search text field above the browse list. 
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7. Click the Fuzzy radio button.

8. Execute the search by pressing the Enter key. Note that the browse list has turned into the 
hitlist, which contains the results (if any). 
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